


IMPORTANT SAFETY INSTRUCTIONS

. Read these instructions.

. Keep these instructions.

. Heed all warnings.

. Follow all instructions.

. Do not use this apparatus near water.
. Clean only with a dry cloth.

. Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.

. Do not install near any heat sources such as radiators, registers, stoves, or other apparatus (including amplifiers) that produce heat.

. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A ground-
ing-type plug has two blades and a third grounding prong. The wide blade or third prong is provided for your safety. If the provided plug does not
fit into your outlet, consult an electrician for replacement of the obsolete outlet.

10. Protect the power cord and plug from being walked on or pinched particularly at plugs, convenience receptacles, and the point where it exits from
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the apparatus.

11. Only use attachments and accessories specified by Rane.

12. Use only with the cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a cart is used, use caution
when moving the cart/apparatus combination to avoid injury from tip-over.

13. Unplug this apparatus during lightning storms or when unused for long periods of time.

14. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power supply
cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does
not operate normally, or has been dropped.

15. The plug on the power cord is the AC mains disconnect device and must remain readily operable. To completely disconnect this apparatus from
the AC mains, disconnect the power supply cord plug from the AC receptacle.

16. This apparatus shall be connected to a mains socket outlet with a protective earthing connection.

17. When permanently connected, an all-pole mains switch with a contact separation of at least 3 mm in each pole shall be incorporated in the electri-
cal installation of the building.

18. If rackmounting, provide adequate ventilation. Equipment may be located above or below this apparatus, but some equipment (like large power
amplifiers) may cause an unacceptable amount of hum or may generate too much heat and degrade the performance of this apparatus.

19. This apparatus may be installed in an industry standard equipment rack. Use screws through all mounting holes to provide the best support.

WARNING: To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture. Apparatus shall not be exposed to dripping
or splashing and no objects filled with liquids, such as vases, shall be placed on the apparatus.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and
can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio commu-
nications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference
to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interfer-
ence by one or more of the following measures:

* Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.
e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
* Consult the dealer or an experienced radio/TV technician for help.
CAUTION: Changes or modifications not expressly approved by Rane Corporation could void the user's authority to operate the equipment.

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme a la norme NMB-003 du Canada.

Shielded CAT5e or better cables are required in order to comply with the FCC Rules part 15 limits for a Class B digital device.

WARNING The symbols shown below are internationally accepted symbols that warn

of potential hazards with electrical products.

CAUTION

RISK OF ELECTRIC SHOCK
DO NOT OPEN

This symbol indicates that a dangerous voltage

constituting a risk of electric shock is present within
this unit.

To reduce the risk of electrical shock, do not open the unit. No user This symbol indicates that there are important

serviceable parts inside. Refer servicing to qualified service personnel. operating and maintenance instructions in the

literature accompanying this uni.
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QUICK START

This section is intended to help you make the physical connec-
tions and software manipulations necessary to get up and run-
ning with your sleek new RPM 2m. If you don’t read the entire
Hardware Manual, at least read this section. It is also recom-
mended that you read the Quick Start section of the Drag Net
Software Manual. If the Drag Net software is not yet installed
on your computer, please install it now.

To be safe, leave the audio connections until last. Begin by
connecting the IEC power cord. Observe that the POWER LED
on the front panel illuminates. After a few seconds, the STATUS
LED should turn from red to yellow to green, and the PRESET
display should have a number in it (00, if it’s the first time you've
powered the device). If the POWER comes on, but the STATUS
LED does not turn green, contact the factory.

Connect one end of the Ethernet crossover cable (supplied
with the unit) to the 10Base-T jack on the rear panel. Connect
the other end of the cable to an Ethernet port on your computer.
The LINK LED on the rear panel should be lit. If it is not, verify
that you are indeed using a crossover cable, not a standard Ether-
net cable. Only use a standard Ethernet cable if you are connect-
ing the RPM 2m and a computer indirectly using an Ethernet
switch. Launch the Drag Net application and follow the steps
to create a new project and new RPM 2m device configuration.
Double-click the Configure Hardware IP shortcut and follow
the instructions to set the unit’s IP address to be compatible with
your computer’s Network settings. 77p: If you aren't sure what IP
to use, try the address 192.168.69.69 and subnet 255.255.255.0.
This finds the default factory address 192.168.69.22 on the RPM

unit,without manually serting it.

WEAR PARTS: This product contains no wear parts.

Now click on the Poll button in the toolbar to find for all
devices. A device name and IP address should appear under the
Live folder in the Project window. If a device does not appear,
consult Drag Net’s online Help for instructions on configuring
and verifying your computer’s Network settings.

The audio path within the RPM 2m is displayed in Drag
Net’s Device Configuration window as a collection of blocks
wired together to form a Processing Map. These maps are cre-
ated offline as Storage configurations, which are then trans-
ferred to a Live unit. Drag blocks from the Palette onto the
Processing Map and wire them together to create the audio
path. Save this file frequently using the File > Save command.
Transfer the selected Storage configuration to a Live unit using
the Transfer Config button in the Project window. A new,
minty green Device Configuration window opens once the
transfer is complete, indicating you are now online with a Live
device. Double-click a processing block to display and adjust its
Properties (parameters) in real time on a Live device — there
is no need to go offline to make parameter changes.

Once you have a useful configuration in the unit, connect
balanced audio INPUTS to the Euroblock o7 XLR connectors,
and connect either or both jack types (if you wish) to the OUT-
PUTS. Then turn on the amplifier. As a precautionary measure,
all outputs are muted during and after a configuration transfer.
Unmute each output individually, or use the handy Mute Out-
puts button in the toolbar. Once all outputs are unmuted, audio
passes through the unit along the connections you defined.
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Front Panel Description
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(@ Signal/Overload LED meters indicate the presence of significant audio signal or overload for Inputs and Outputs. These 3-color
meters indicate the available headroom once the analog signal has been converted to digital: -4 dBES (red, near clipping), -12
dBEFS (yellow, high normal level), and -48 dBES (green, low level). The signal level in the RPM 2m depends on the input and
output settings and is displayed in Drag Net’s Meter window when the Converters tab is selected.

(@ PRESET LED displays the number of the most recently recalled Preset, numbered 0 through 24.

(® VIP LED flashes when a change is detected on the Versatile Input Port (VIP). This port is used for direct electrical connections to
potentiometers, switches or other logic ports. See page Manual-4 for details.

@ ETHERNET LED flashes when an Ethernet data packet for this device is received.

(® STATUS LED reflects the overall status of the unit:
Red - initializing (briefly) or possible internal error (steady).
Yellow - working, but not yet processing audio.
Green - processing audio.

(® POWER LED lights yellow when the unit is powered on.

Rear Panel Description
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(@ POWER IEC jack connects to AC line voltage, 100-240 VAC £10%.

(2 Balanced analog audio INPUTS 1 and 2 on Euroblock and XLR connectors. See “Audio Connections” on the following page.
(® Balanced analog audio OUTPUTS 1 and 2 on Euroblock and XLR connectors.

@ AES3 digital audio OUTPUT uses a fixed 48 kHz sample rate and 24-bit word length. See “Audio Connections.”

(® VERSATILE INPUT PORT provides 8 logic or voltage inputs for remote level control and Preset recall on a Euroblock.

(® LAN and LINK reflect the state of the Ethernet connection. LINK lights solidly when a valid connection to another Ethernet
device (e.g., a PC or network) is detected. LAN flashes when communicating with another Ethernet device.

@ 10Base-T jack accepts a standard Ethernet cable with a RJ-45 connector.

DEFAULT button recalls Preset 1 when pressed. Holding this button while applying power puts the unit into a special codeload
mode for updating firmware.
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Audio Connections

As a safety precaution, turn all devices (especially power amplifi-
ers) OFF when making connections. Doing so gives you a chance
to find and correct wiring mistakes and prevent damage to your
amplifiers, speakers, ears, pets, etc.

Analog Inputs and Outputs
The RPM 2m has two balanced analog Inputs, two balanced
analog Outputs and one AES3 digital Output.

XLR and euroblock connectors are both provided for your
convenience. Feel free to use either (but not both!) for each
Input. Both Output types may be used if desired. For each Input
or Output Euroblock connector:

* Connect the (positive) audio line to the ‘+” terminal.
* Connect the (negative) audio line to the - terminal.
* Connect the cable shield to the 2 terminal.

For those installations where the RPM 2m internal shield-
to-chassis connection causes interference, connect each shield
directly to the chassis screw located above each Euroblock con-
nector, keeping the shield wrapped around the audio conductors
as much as possible.

For optimum Electromagnetic Interference (EMI) immunity,
connect the shields at both ends of the cable. See the RaneNote
“Sound System Interconnection” for more information on system
connections and proper grounding practices.

Analog Input Stage

Each analog input uses a studio-grade microphone preamp

and an independent line-stage input. The input connectors are
switched between the mic pre and the line stage by a relay that is
controlled by the user interface.

The mic pre has two analog gain stages. The input stage
controls gain in large 15 dB steps. The second analog-gain stage
makes the fine 1 dB gain adjustments. Gain is optimized for best
overload characteristics. If noise performance is of greater impor-
tance, then overload performance can be traded for the best noise
performance by using microphone gains of 15, 30, 45 and 60 dB.

As an example: if the desired mic pre gain is 40 dB, best
overload performance is obtained by setting mic gain to 40 dB
and setting the digital trim to 0 dB. Best noise performance is
obtained by setting mic pre gain to 45 dB and setting the digital
trim to -5 dB (this will cut the top-end headroom by 5 dB). If
this is confusing, just leave the digital trim alone (set to 0 dB)
and use the mic-pre gain slider to set mic gain. For the best noise
performance, only use the digital trim to cut gain.

A high-performance line stage is provided that happily ac-
cepts the hot +24 dBu signals from professional audio sources all
day. When using non-pro -10 dBV audio sources, select the +12
dB line gain level, or for even better noise performance, use the
mic pre at the 15 dB setting and set digital trim to -3 dB. When
you're hooking up a consumer CD player with a single-ended
output (for example) and you really need an extra 6 dB of gain
(for a total of 18 dB of front-end gain), set the mic pre to 18 dB.

WARNING: when using the mic pre as a low-noise line
stage, make sure the phantom power is turned off!

Analog Output Stage
Analog output is real easy. There is a Digital Trim control located
immediately before the D/A converter. It’s as simple as that.

AES3 Output
AES3 is a popular 2-channel (stereo) digital audio interface
commonly found on professional digital audio equipment
(digital mixers, DAT machines, etc.). Each channel of the AES3
digital stream is treated independently within the RPM 2m.
See the RaneNote “Interfacing AES3 and S/PDIE”, available
from Rane’s website (www.rane.com/library.html), for informa-
tion about interfacing consumer S/PDIF gear to the professional
AES3 standard.
Use the AES3 Output to:
* Feed audio to RPM 88/44/22/267’s to create a 2-channel digi-
tal “bus” between devices.
* Connect directly to the AES3 input of a digital mixing console.
¢ Connect directly to the AES3 input of a DAT machine for
recording purposes.
* Connect to an external D/A converter, effectively adding two
more analog outputs.

Control Connections

Versatile Input Port (VIP)

Eight logic input pins are provided, each capable of accepting

DC voltage between 0-5 VDC. VIP pins are used with contact

closure switches for Preset recall, or with potentiometers for

remote Level control. The functionality (Preset recall versus

control) of each pin is assignable as part of the Device Configu-

ration.

* The maximum allowable voltage on any VIP pin is 5.3 VDC.

* Use of twisted pair cable is recommended for lower noise.

* If an external device is used to generate a 0 to 5 volt signal,
connect the ground of the external device to the VIP GND.

Preset Recall Using Contact Closure Switches

The minimum “low” voltage required to detect a contact closure
and change Presets is 2.5 V. Since the internal pull up is 100 kQ
to +5 V, it is possible to calculate the maximum allowable cable
length, provided the wire resistance per foot (or meter) is known.

Example:

To be safe, let’s allow a maximum of 80 k() worth of cable
resistance. This value keeps the voltage divider formed by the
100 kQ internal resistance and 80 k() cable resistance from
dropping below 2.5 V.

(5V*100kQ) /(100 kQ + 80 kD) =2.777V

If the cable resistance is 30 Q per 1,000 feet (305 meters)

(1,000 ft / 30 Q) * 80,000 Q = 2,666,666 ft (813 km)

Thus, you can only use 2,666,666 feet (505 miles) of twisted
pair cable before the Preset recall functionality becomes inter-
mittent (assuming the cable is properly twisted and not run
through excessive magnetic or electric fields).
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Remote Level Control Using Potentiometers

The VIP inherently prefers linear taper 20 kQ potentiometers
(Rane VR 2), which provide a nice audio taper “feel” for the
end user. When used with suitable twisted pair wiring, the 10
kQ value also offers acceptable noise immunity and long cable
lengths.

AMX and Crestron Control

There are two ways to control a Drag Net device from an AMX
or Crestron system. Use either Ethernet connectivity or use the
rear panel Versatile Input Port (VIP). Each of the eight VIP pins
supports either switch closure Preset recall or 0-5 volt control of
Level.

Many AMX/Crestron applications require simple Level con-
trol and/or Preset recall. This is most easily accomplished using
the VIP (Versatile Input Port) found on all Drag Net devices.
There are always more Drag Net products coming — both hard-
ware and software, so check our home page for the most recent.

VIP Preset Recall

Connect a switch closure or relay to a VIP pin and short it to

the ground (GND) pin to recall the corresponding Preset. For
example, shorting VIP pin 1 to the GND terminal recalls Preset
1; pin 2 recalls Preset 2, etc. There are more details about this
functionality in the Drag Net Help file and on our Drag Net Ap-
plications page. Be certain to appropriately set the VIP Alloca-
tion in Drag Net's Parameter Window.

If GND contention of two or more pins simultaneously
occurs, the highest-numbered VIP pin takes precedence. For
example, if pin 3 is shorted to GND and pin 6 is then shorted
to GND, Preset 6 is recalled. If pin 3 is closed and then pin 2,
nothing happens -- Preset 2 is not recalled. This permits a hier-
archy of Presets when using VIP pin closures for tiered priority
paging. Since there are only eight VIP pins, you can only recall
up to eight Presets using switch closures.

There are two ways to recall more than eight presets. Either
use the Drag Net software Recall button which is only intended
for the system installer/designer, or use an Ethernet command
from an AMX or Crestron Ethernet-equipped product.

When using Drag Net's Auto Mixer/Ducker block, you have the
ability to link a VIP pin closure to a push-to-talk switch in a paging
or boardroom application. When using the Ducker block in these
applications, the VIP pins act independently provided you Group
the appropriate VIP pin with the Auto Mixer/Ducker's Input in
Drag Net's Remote Map. Again, see our Drag Net Applications for
examples.

VIP CONNECTION
(examples for VIP pin 1)

pin 1 T REF
pin1  —T=> 20kQ (linear)
GND GND
Contact Potentiometer
Closure Level Control
VIP Level control

Connect a 0-5 VDC source to a VIP pin from an AMX or
Crestron card to adjust any or all Level blocks placed in the
Processing Map. Use Groups in Drag Net's Remote Map to link
one or more Level blocks so they track each other when using a
VIP pin. Be certain to appropriately set the VIP Allocation in
Drag Net's Parameter Window. When using VIP pins with Level
blocks, set the minimum and maximum for each Level block by
double-clicking it while it's in a Remote Map Group. This keeps
the max and min burdens within the Drag Net device — but
only when using the VIP pin to control Levels, not when adjust-
ing Levels from Ethernet commands.

You can use up to eight voltage control inputs linked to
Level(s) using the rear panel VIP pins. Combinations of Preset
switches & voltage Level “pots” are possible as long as combined,
they do not exceed the eight pins provided.

Since you can Group any or all Level blocks in Drag Net's
Remote Map, it's much easier to implement a stereo level control
since the Drag Net device is burdened with the task of tracking
many Levels. You can use this to your advantage when using VIP
pins to adjust multiple zones or levels. Since you can place the
Level block anywhere within the Drag Net Processing Map, you
can Group Level blocks at the input, at the output or anywhere
in-between — just place the Level block where you want it.

Ethernet control
To download the AMX or Crestron control code and documen-
tation, visit the Drag Net web page: www.rane.com/dragnet

Ethernet Port
The Ethernet port is used to configure, monitor, and control the
RPM 2m via standard 10Base-T Ethernet communication. Use
an Ethernet crossover cable (one is included with each unit) to
connect the RPM 2m directly to a computer. Use a standard
(non-crossover) Ethernet cable if the RPM 2m and computer are
connected indirectly using an Ethernet switch.

All devices connected to the Ethernet port, including
switches and the computer’s Network Interface Card (NIC) must
support 10Base-T' communication.

©Rane Corporation 10802 47th Ave. W., Mukilteo WA 98275-5098 USA TEL 425-355-6000 FAX 425-347-7757 WEB www.rane.com

Manual-4

111218



Drag Net Quick Start

Rane’s tradition of writing a one page Quick Start section in our
manuals has been revamped. Since this section is four pages, it’s
called the Mostly Quick Start section.

Drag Net software installation is straight forward — just
run the setup.exe file included on the CD-ROM or downloaded
from Rane's website (www.rane.com/dragner) and follow the on-
screen instructions.

You are prompted to create a new project and device con-
figuration the first time Drag Net is launched. Enter the project
name and file storage location on your hard drive. A second
dialog allows you to create a new device configuration. Select a
device type, RPM 26z for example, and specify a hard drive stor-
age location to create a new configuration.

Once a new project and configuration have been created, a
collection of windows is displayed within the Drag Net interface.
These windows can be independently resized, opened, closed,
docked and floated as you prefer.

Project
@ ¢ @
Mﬁ Transfer Config To e - @(

=13 Storage
RPMS8_1
3 rPM26_1
Rane Drag Met Paramount Theater
B revz_1
=-IC5) Shortouts
%_n" Configure Hardware IP

@ Rane Corporation
= TF"' Live
=-E8 Metwork Adapter - Ethernet
D Hello World [192. 168.48. 113]
;,f COM Port(s) - Serial

The Project Window is comprised of three folders and provides
links to Storage configurations, Shortcut links to other files or
applications, and a list of Live devices. Think of a Project as an
editable database of links — only the /inks to files are contained
in the Project file (*.prj file extension). The Project file neither
stores nor contains any of the settings for a particular device
configuration, it just consolidates and manages links to the rel-
evant files (for examples, the RPM 26z configurations are stored
with a .r26 file extension, and the RPM 88 configurations have a
.r88 extension). Changes to a Project's contents are automatically
saved. Only one Project at a time can be viewed in the Project
window.

* The Storage folder displays a list of “offline” or Storage
configurations residing on the local hard drive. Add links
to new or existing configurations to the Storage folder by
right-clicking within the Project window and selecting

either New or Add file(s).

 The Shortcuts folder displays a list of links to non-Drag
Net files or applications (e.g. project spreadsheets, proposal
documents), URLs, and even email recipients. Double-
click on a Shortcut to open it using the associated applica-
tion. Add additional links to the Shortcuts folder by right-
clicking within the Project window and selecting New.

e The Live folder displays a list of “online” Drag Net devices.
Click on the Poll icon or right-click in the Project window
and select Poll for devices, then choose one of the polling
options. The Live folder is populated as the polling opera-
tion progresses.

Transfer configurations between Storage and Live by dragging and
dropping configurations from one folder to another, or by using the
Transfer menu.

All outputs are intentionally muted each time a new configura-
tion is transferred to a Live device. Unmute each output individual-
by or use the Mute Outputs button in the toolbar to toggle the mute
status of all outputs (after carefully pondering the consequences, of
course).

]
Analog Input 1 Laval =
D I |
Dk Lo e Auto Mixe
] | F\_’ Lob
Analog Input 2 l el L
D
n [ [] =Ny |-
D
v
< | 1 | (2]

| ;o Processing map |f:g Remote map |

The Device Configuration Window displays the current device
configuration, activated by double-clicking a Storage or Live
configuration (or alternately by right-clicking and selecting Open
Item). It is comprised of two distinct views: the Processing Map
and the Remote Map. Toggle between views using the tabs at the
bottom of the window. The Processing Map serves two basic
functions:

* It allows drag and drop techniques to assemble and connect
any combination of signal processing blocks between the in-
puts and outputs of a Storage configuration. It is not possible
to add or delete signal processing blocks or connections on a
Live configuration.

* Jtallows you to view and edit, in real-time, all signal process-
ing parameters for Storage or Live configurations. Double-
click the processing block or right-click and select Properties
to display a Properties (parameters) dialog. Changes made to a
Live configuration are automatically transferred to and saved
in the Live device. Changes made to a Storage configuration
must be saved using the Save command.

Drag Net Quick Start-1
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The Remote Map is used to configure the Versatile Input Port
(VIP) and the RW-485 Remote Interface Port, if the RPM unit
is so equipped. The VIP accepts either contact closure switches
for Preset recall, or 0-5V potentiometer-on-a-wall devices for
Level control. Double-click Edit VIP Properties in the Parameter
Window to allocate multi-pin or single-pin control. Multi-pin
control is used with contact closure switches to recall Presets,

or to select inputs in a Source Selector, for example. Single-pin
control is used for independent parameter control: to adjust levels
using a potentiometer, or to engage the Push-to-Talk function of
an Auto-Mixer input, as examples. See the “Using the Remote
Map” section of Drag Net's Help (Help > Help Topics) for the
full scoop.

The Remote Interface Port uses Rane's RW 485 protocol to
communicate with our SR series of Smart Remotes. Double-click
Add/Edit Remotes in the Paremeter window and follow the on-
screen instructions to add new Remotes or edit existing Remotes.

Clidk here for remote map help

[l

Smart Remotes can perform many functions including Preset
Recall, Source Selection, and Level control. See the “Using the
Remote Map” section of Drag Net’s Help (Help > Help Topics)
for more information.
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The Preset Window manages the creation and storage of Presets.
A Preset may contain any or all of the processing and control
blocks displayed in the Device Configuration window. Add
blocks to the Preset block list by dragging and dropping them
from the Device Configuration window to the Preset window,

or by right-clicking the block and
selecting Add to preset. Remove
blocks from the Preset window by Al
selecting one or more blocks from

Palette -

the list, then using the Delete key 3 Compressor

or the Remove Selected Block(s) 4 Monao 5-C Compressar
button. Click the Store button and

select a Preset number to store the (= Stereo 5-C Compressor

current settings of all blocks con-

tained in the Preset block list.
Presets are recalled using

the Recall Presets button in the

toolbar at the top of the screen.

9 Limiter
8 AGC
+ [ Ambient Noize Comp

When a Preset is recalled, only the | 9 pymetric
parameters or Remote Map as-

sociations of the blocks contained | (] 30-Band Graphic EQ
in the Preset change; all other

blocks maintain t}%eir current set- ] Feedback Suppressor
tings, thereby creating a parameter | [* 2away crossover
overlay effect. The Preset window

does not have to be visible in order (] 3way crossover

to recall Presets. P Matrix Mixer

The Palette Window displays
the audio processing blocks used

™9 Auto Micer / Ducher

to create Storage configurations. 5 e Nx 1
Drag and drop blocks from the | Select 1of N
Palette to the Device Configura-
tion window to develop your I Level
audio system. The various tabs

1 Delay

(Dynamics, Mix, etc.) are used to
sort the Palette window by block
class. Select the All tab to display
all available blocks.
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Propagation Delay @ 68 degrees F
Analog In = Analog Out: 1.43 ms (1.61 fi)
Analog In = Digital Out: 1.75 ms (1.97 ft)

Digital In = Analog Out: 1.47 ms (1.66 f)
Digital In > Digital Out: 1.79 me (2.02 ft}

Resource

The Resource Window displays usage information specific to
the hardware device you're working with. The DSP usage meter
indicates the amount of DSP "horsepower” used by the current
configuration, and is always accurate. There is no need to hita
“compile” button, since Drag Net automatically compiles on the
fly as you work. It is possible to exceed 100% DSP usage when
developing Storage configurations, but it is not possible to trans-
fer the Storage configuration to a Live device. The Delay blocks
meter indicates the amount of audio delay memory used in the
current configuration. Audio delay memory differs from memory
used by other signal processing functions; thus, it is given its
own meter.

Propagation delay (latency) statistics for both the analog
/0 and the AES3 digital Input are also displayed in the Re-
source window. The propagation delay varies slightly with the
quantity of signal processing blocks used in the configuration.
Importantly, the propagation delay for all analog I/O is forced to
be the same (referred to as “Delay Compensation”), in order to
maintain the relative timing between input signals (unless you
add a Delay block to the signal path, of course).

. Analog [ Converters |

The Meter Window provides two tabbed views of all input and
output levels of a Live device. The Analog tab shows the calcu-
lated level, in dBu, at each analog input and output.

The Converters tab displays the dB Full Scale (dBFS) read-
ing immediately after the input A/D converters and immediately
before the output D/A converters. The AES3 digital input meter
(dBEYS) is displayed in both views.

The number of meters provided varies with device type. Me-
ters are only active when working with a Live device.
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----- ## Preset Recal

The Parameter Window displays a tree structure view of all
signal processing and control blocks used in the active Device
Configuration. It is organized by block type (Input, Output,
Dynamics, Filter, etc.), with individual parameters appearing as
sub-entries beneath each block entry.

Individual parameters within a block are prefaced with “##”.

The Parameter window is primarily used to set up associa-
tions between parameters and remote control devices (VIP pins,
Smart Remotes).

Other things you can do with the Parameter window:

* Double-click any entry to view its Properties dialog.

* Drag-and drop entries from the Parameter window into the
Preset window to quickly build Presets.

* Edit VIP Properties.

¢ Add or Edit RW 485 Smart Remotes.

* Edit VOP Properties.

Handy tip: The Parameter window supports multi-select oper-
ations. Simply ctrl-click or shift-click multiple entries to perform
the same action for the entire selection — add a range of blocks to
the Preset window, for example. Alternately, you can select a top
level block — the Input block, for example — and perform actions
on all related sub-entries.
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Big Picture Concepts

Storage Mode versus Live Mode

When you first create a Drag Net device configuration, it is
stored and appears under the Storage folder of the Project Win-
dow. Think of this as offfine mode. Any changes made to Storage
configuration are saved to your computer only; they are not
updated automatically on the Live device.

Storage configurations are transferred to a Live device, which
appears under the Live folder of the Project window after suc-
cessfully polling for devices.

After transferring the configuration from Storage to Live you
can adjust parameters, build Presets, and set up Remote Map
associations in real time on the Live device. You can not add/de-
lete blocks or wires. Think of this as on/ine mode. All changes
are automatically saved to the Live device; however, periodically
transfer the Live device settings back to a new or existing Storage
configuration in order to maintain an offline (backup) copy of
system settings. Live device settings are not automatically kept in
synch with Storage configurations.

File Concepts

A Storage configuration consists of:

* The Processing Map (schematic/audio signal flow).

* Parameter settings (gains, delay, EQ, etc.) and Preset info.
* Remote Map link info.

In Drag Net 4.2 and higher, these items are stored in a single
configuration file (see Project Window on page 1). This makes it
easier to track, transfer between computers or email your Drag
Net configurations. Previous to 4.2, this data was in three inde-
pendent files.

Dragging Tips (Storage mode)

Audio flow: Drag and drop blocks from the Palette window
to the Processing Map to build the audio portion of a Device
Configuration.

Control: Drag and drop items from the Parameter window
to the Remote Map to build the control portion of a Device
Configuration.

Move blocks around the Device Configuration window by
left-clicking the block to select it, then dragging the block to a
new location while continuing to hold down the mouse button.
Alternately, left-click the block to select it, hold down the CTRL
key, then use the arrow keys to reposition the block.

Drag and drop blocks from the Device Configuration win-
dow to the Preset window to add blocks to the Preset block list.

Drag and drop configurations between the Storage and Live
folders in the Project window to transfer configurations between
the PC and a Live unit.

Wiring Tips (Storage mode)
Wires can be dragged from Out pins to In pins found on each
processmg block. A couple tips:
You must wire from an Out pin to an In pin.
e Any Out pin can be wired to as many In pins as desired
— a dedicated split block is not required. It is not possible,
however, to connect multiple Out pins to a single In pin. Use
mixers or selectors for this purpose.

Presets

The current settings of a device (all Properties, or parameters) are
always stored in working memory and displayed in the Device
Configuration window, making for a true WYSIWYG (What
You See Is What You Get) interface. Each user-definable Preset
can store processing block Properties and Remote Map settings
for subsequent recall. A Preset can be comprised of any or all
processing or control elements displayed in the Device Configu-
ration window.

Only the processing parameters and the Remote Map set-
tings are stored in Presets — it is not possible to change the wire
routing or signal flow using Presets. If you require a completely
new signal flow, you must either draw all required parts of the
system in the Processing Map and then toggle Presets to route
the audio between the various system blocks using selectors or
mixers, or transfer a new Storage configuration from the PC to
the Live device.

Storing to Presets

Click the Add All Blocks button, located next to the Store
Preset button in the Preset window, to populate the Preset block
list (Name/Type) with all blocks on the Processing Map. Store a
Preset by clicking the Store Preset button and selecting a Preset
number. The current settings of each block in the list are stored,
the device configuration is automatically saved, and the stored
Preset is automatically recalled.

It is also possible to store and recall a subset of processing
and control blocks. Drag and drop (or alternately right-click a
block and choose Add to Preset) only the blocks you want stored
in the Preset from the Device Configuration window to the
Preset window. When the Preset is recalled, only the settings of
the blocks contained in the Preset are modified; all other blocks
remain unchanged from their current state. Thus, recalling
the Preset “overlays” the current settings with a subset of new
parameters.

Recalling Presets

The Recall Preset button in the toolbar at the top of the screen
recalls previously stored Presets. When a Preset is recalled, its
number is displayed in the upper right corner of the Preset win-
dow, the block list in the Preset window is populated, and small
numbered tags appear in the lower right corner of each process-
ing or control block comprising the recalled Preset. Clear these
tags by right-clicking within the Device Configuration window
and selecting Clear all preset tags.

©Rane Corporation 10802 47th Ave. W., Mukilteo WA 98275-5098 USA TEL 425-355-6000 FAX 425-347-7757 WEB www.rane.com

Drag Net Quick Start-4

106405





